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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at leese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemarkninger angdende
brugen af din skarm.

Philips garanti daekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker:

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen vek fra direkte
sollys, meget staerkt og lyst lys samt fra alle
varmekilder. Laengere tids udseettelse for
sadan et miljg kan resultere i misfarvning
og skade pa skeermen.

* Fjern alt, der kan risikere at falde i
ventilationsdbningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsdbningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til strgmstikket
og stikkontakten.

*  Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du sztter

stremkablet eller jeevnstrgmsledningen til
igen for at opna normal betjening.

* Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udset ikke skaermen for kraftige
vibrationer eller sted under anvendelse.

*  Sld ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

*  Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skaermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at lgfte den. Laft ikke
skeermen ved at satte din hand eller fingre
pa LCD skeaermen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en leengere periode.

» Tag stikket ud at kontakten til skaermen,
hvis du skal renggre den med en let fugtet
klud. Skaermen kan tgrres af med en tor
klud, nar der er slukket for stremmen.
Under alle omstandigheder, ma der ikke
bruges organiske oplasningsmidler til
rengering af din skaerm.

» For at undga risiko for elektrisk sted eller
permanent beskadigelse af anlaegget, ma du
ikke udseette skaermen for stev, regn, vand
eller miljger med hgj fugtighed.

*  Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind i skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

»  Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der



er indenfor fzlgende temperatur- og
fugtighedsomrade.

e Temperatur: 0-40°C 32-95°F

*  Fugtighed: 20-80 % RH

Vigtige oplysninger om fastbraendte billeder/

spogelsesbilleder.

* Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskerm eller et andet program,
der opdaterer skeermen regelmassigt,
hvis skaermen viser statisk materiale
i lengere perioder. Uafbrudt visning
af et stilbillede over leengere tid, kan
fordrsage "“brandmaerker”, ogsa kendt som
“efterbilleder” eller “spagelsesbilleder” pa
skaermen.

“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfeelde vil “brandmarkerne’” eller
“efterbilledet” eller “spogelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Hvis der ikke aktiveres en pauseskeerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spagelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstdende skade dakkes ikke af
garantien.

Service
e Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter”)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

= Bemeark

Kontakt en servicetekniker, hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal ggre, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.



1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2 Opszetning af skeer'm B Installation af stander

1. Anbring skeermen med forsiden vendt
nedad pa en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1] Emballagens indhold 2. Pasazt/skyd basesgjlen pa skeermen, indtil

den klikker pa plads.

%%art

PHILIPS

Hold pa skeermens stander med begge
haender, og st med en fast hand standeren
ind i fodsgjlen.

Power Cable *VGA Cable

* Afheenger af landet
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© AC stromindgang
© VGA-indgang
© Kensington anti-tyverisikring
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@ AC stremindgang

(2] VGA-indgang

© HDMl-indgang

(4] Kensington anti-tyverisikring

Tilslutning til pc
1. Tilslut ledningen ordentligt pa bagsiden af
skaermen.

2. Sluk for computeren og tag netledningen
ud af stikket.

3. Slut skaermens signalkabel til videostikket
bag pa computeren.

4. Seet computerens og skaermens
netledninger til et stik i naerheden.

5. Teend for computeren og skaermen. Hvis
skaermen viser et billede, er installationen
gennemfort.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra

E1 Beskrivelse af OSD-visningen
Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skeerme. Den szetter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skeermens funktioner direkte via et
instruktionsvindue pa skeermen. Et brugervenligt
skaermvisningsinterface vises som nedenfor:

203V5LHSB2:

O e o

d) Teender og slukker for skaermen.

) | Siifter tislutningskilden.

.
>

'O' Justerer lysstyrkeniveau.
* []

I:- Justerer kontrastniveau.

AUTO | Automatisk justering af skaermen.

Indstil sprog
@ Vis information

D Forlad skaeermmenu

-

*




Hvordan justerer jeg skermmenuen med én OSD-menuen

knap? Nedenstdende er en generel oversigt over
1. Knappen pa bunden af the forsiden af strukturen i OSD-displayet. Du kan anvende
skaermen har to funktioner; teende/slukke for den som opslag, nar du senere skal orientere
skaeermen og indstilling af skeermmenuen. dig i de forskellige justeringer.

Main menu

N VGA
—Input E DVI (available for selective models)
HDMI (available for selective models)
——————
Pict r— Picture Format — Wide Screen, 4:3
z o [—Ficture
2. Tend for skeermen ved at trykke én gang pa — Brightness — 0~100
denne knap . — Contrast — 0~100
3. Trykigen pa knappen pa forsiden af [ SmartContrast  — On, Off
skaermen for at ga til skeermmenuen. —— OverScan — On. Of
——Audio — Volume — 0~100
p—— —— - (available for — Mute — On, Off
—_— = selective models) L—  Aydio Source — Audio In, HDMI
203V5LHSB2:
+—Color — Color Temperature — 6500K, 9300K
Q) _@ ‘ & — sRGB
: — User Define Red: 0~100
= = E Green: 0~100
Blue: 0~100
4, Dukan nu V&lge en funktion ved hurtigt +—Language — English, Deutsch, Espafiol, ENnvikij, Frangais, Italiano,
at try|<|<e gentagne gange pé knappen. Den bld Maryar, Nederlands, Portugués, Portuguési do Brazil,
boks fl il hai 2 d ke 2 Polski , Pycckuit, Svenska, Suomi, Tiirkge, Cestina,
oks fiyttes til hojre, nar du trykker pa knappen. Vipaikcoka, TR, SEREERC, B AR, &1l
Nar den bla boks markerer funktionen, som du
gnsker at vaelge, skal du slippe knappen. Bemaerk, | 0SD Setcings — Horizontal — 0~100
markeringen fl Itid i én retning i en
at‘ arkeringe )fttes atld en retning i e | Vertical 04100
slgjfe og vender tilbage til toppen af menuen.
. , . — T — Off,1,2,3,4
5. Den bl& boks forbliver p& den valgte ransparency
funktion i ca. 3 sekunder og funktionsikonet —— OSD Time Out ~ — 5, 10s, 205, 30s, 60s
blinker tre gange for at bekreefte valget pa det 1.
lag i skeermmenuen og for at aktivere den. ——Setup r— Auto
6. For at veelge sprog skal du trykke [ H.Position — 0~100
pa knappen, veelge globus-symbolet pa — V. Position — 0~100
skeermmenuen og aktivere den. Der vises en o 0100
. . . [ Phase — 0~
liste over sprog i menuen.Tryk gentage gange pa
knappen og rul igennem sprogene. Naviger den [ Clock T 0~100
blé boks til det gnskede sprog, hvorefter det |__ Resolution _
. Notification On, Off
aktiveres.
— Reset — Yes, No
7. For at justere lysstyrke eller kontrast, skal du
L— Information

trykke pa knappen, vealge funktionen og aktivere
den.Tryk igen pa knappen for at foretage
indstillingen. Bemaerk, at markeringen flyttes
altid i én retning i en slgjfe og vender tilbage til
toppen af menuen.



El Meddelelse om oplesning

Denne skaerm er fremstillet til optimal ydelse pa
dens native opl@sning, som er 1600 x 900 @ 60
Hz. Nar skeermen bruger en anden oplgsning,
ses fglgende advarsel pa skeermen: Brug 1600 x
900 @ 60 Hz for at opna det bedste resultat.

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

Kl Fijernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jaevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




© Bemarkning
Denne skaerm accepterer et 100 x 100 mm
VESA-kompliant monteringsinterface.

PHILPS

100mm

100mm,




3. Billedoptimering

Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skaermel!

B Installation

3.1 SmartContrast .

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pd en merk
baggrund.

B Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, leesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens stremforbrug, sparer du
energiomkostninger og forlenger skaermens
levetid.

El Hvordan virker det? .
Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og .
baggrundslysets intensitet indstilles. Denne

funktion forbedrer den dynamiske kontrast og .

giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hegrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, og er tilmed

10

Felg instruktionen og fuldfer installationen.
Du kan starte, nar installationen er fuldfert.

Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS

www: philips.com/welcome

Monitor drive

r and software installation

7, Vs XP, 200098,

Opstartsguide

Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

Guiden leder dig trin for trin gennem
indstillingen af skeermen.

Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

| Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



B SmartControl 2 - Phiips 22581 (C530715000001) |2 (X
SmartControl Lite PHILIPS

Wizard

ibrate your display to get the most

e encourage you to use the smple

selecting the Start Wizard button.
t wil ket you

tune your dsplay and save the settings.
1. Choose the Start Wizard button.

2. Folow the steps outined i this process.
Save your settng

il

Adiust Audio

Auto Pivot

i

-
Color Input

L

Weard
2

Presets

Muki Montors

L3

Help

Start Weard

Bl Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):

* Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplgsning).

» Udfer indstillingen ved at folge
instruktionerne.

e Installationen kan annulleres med Cancel
(Annuller).

8 smartControl 2- Phiips 22581 (C530715000001) (2)\X;

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wi result n 3 oss of
etai in darker image areas. Adjust the Brightness for
the best possble picture quaity.
1. Lower the Brightness to the minimum level,
2. Rase the Brightness to the desred level.
3. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Adiust
Brightness
Color —
A
g Fag Brightness 100
\ * - :
Options Undo Reset
Help

' smartControl

SmartControl Lite

Adjust
srghtess
Coor oy
B
" Foaus
gy
\@ Postion
Optons s
! Resoltion
Help
1 Smartcontrol

SmartControl Lite

]

Adiust
Brghtness
\g Contrast
Color %
4
. Focus
N
\g Postion
Options. %
Resoluton

®

Help

8 smartcontrol

SmartControl Lite

Adiust

8rightness

Contrast

3R
A
au

Postion

w

Resolution

2-Phips 22581 (cs3071500000) (Z](X
PHILIPS

Contrast
Adjust the Contrast (use the sider) to keep detais in
lghter image areas.
1. Rase the Contrast unti the numbers 1and 2
visble.
2. Slowly lower the Contrast to make the

numbers 2 and 3 reappear. The number 1
should remain barely visble

Contrast. 50

+

Undo Reset

2 - Philps 22581 (C530715000001) (Z)\ X
PHILIPS

Focus
Your dsplay's timng needs to be synchrongzed with
the video signal

Auto Setup.
ical bands are stil visble, you'l need

3l bands dissppear.
st setting to minmaze
movement on the screen.

Pitch

&g

Phase

(™

Undo Auto Setup

2. Phips 22581 (Cs30715000001) (7] X
PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or rig
1. Use the Up/Down buttons to center the image
verticaly.
2. Use the Left/Rght buttons to center the image
horzontaly.

Undo Reset




8 smartControl

SmartControl Lite

srghtess
\g Contrast
Color AR
3R
" Focus
sy Ny
\Q Postion

!! n;sammn
Help

2 - Phips 22581 (C530715000001) {Z]X

PHILIPS

Resolution

You are currently at  Preferred resolution. For your
display to show crisp, clear text, colors, and images,
‘your display should be set to tts Preferred resolution.
If your display is at a Non-Preferred resolution, click
on the Preferred button to change your resolution to

I Enable Resolution Notfier

Picture Format
I 43 aect o

Preferred

M=

Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration

(farvekalibrering).

»  Udfer indstillingen ved at folge

instruktionerne.

* Se nedenstaende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):
8 smartcontrol

SmartControl Lite

]

Adiust s
Black Level
White Pont

Display Gamma

il

|
Options Calbration

&

Help

2.-Philps 22581 (C530715000001) (%)X
PHILIPS

Black Level

Improperly adjusted Black Level wil resut i 3 loss of
detai n darker mage areas. Adjust the Black Level for
the best possble picture qualty.
1. Adjust the biack level of the Red, Green, and
Blue using the sider bars.

Red 50

= C &

Green 50

o © &

Ble 50

=) o @
Undo Reset

12

' smartControl

SmartControl Lite

]

Adjust Rea
Back Level

e Pont

Display Gamma

g

Options Calbration

&

Help

8 smartcontol

SmartControl Lite

]

Adjust RGB
Color White Point
= b
Display Gamma
-l
Options Calbration

®

Help

8 smartcontol

SmartControl Lite

w

Adjust RGB
sk tevel
Color White Pont
AN #
\g Dspby Gamma
Options Galbration
Help

2 - Phiips 22581 (€S30715000001) {Z](X)

PHILIPS

White Point

‘White Point i the pont at which equal combmations
of red, green, and blue light at ful intensty create
white. This effects the overal color qualty. For the
most accurate colors cick the Reset button then
select the Whie Point.
1. Please select the White Point value for the best
possible color qualty.

White Point 6500K

Undo Reset

2 phips 22581 (CS30715000001) (2 (%)
PHILIPS

Display Gamma

ima & 2 component of the pixelbrightness n 3
display. A lower Gamma value produces brighter pixels
and 2 higher Gamma value produces darker pixels. The
defau value for Gamma is 2.2.
o adjust Gamme, Smartlmage must be et to OF.
Click the SmartImage Off button before adjusting
Gamma,

1. Use the sider to select the desred Gamm.

Diplay Gamma

[N

Smartimage Off

Undo Reset.

2- Philps 22581 (CS30715000001) [

PHILIPS

Calibration

Your dispiay needs to be properly calibrated i order
for t to produce the widest range of cokrs accurately.
Calibration should ahways take place as the kst tuning
step i the process. Remember to recalbrate any time
you make indiidual adjustments to image quakty or
whenever you move your dsplay to 2 new location.
Make all other necessary adjustments to image
qualey frst.
. Press Show Me to leam how to use the
calibration toos.
Faly, press Start to begn the calibration
process.

R Enable color caibration
Color software desgned i colaboration with Joseph

jomes.
Protected by LS. Patent No. 6,686,953

Show Me start

Quick View



“Show Me” (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleeser fer/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskaerm:

Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskarm.

Next (Naste) gar til efterfalgende mal
(seks mal).

Ga til sidst til File > Presets (File > Forvalg)
vinduet.

Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

13

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pd en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

8 SmartControl 2 phips 22581 (CS30715000001) (2)\X)

SmartControl Lite PHILIPS

Preferences

e the following options to configure
ol.

* Viser nuvarende, foretrukne indstillinger.

*  Funktionen aktiveres ved at afmaerke feltet.
Afmarkningsfeltet er en flip-flop.

* Enable Context Menu (Aktivér Indhold
menuen) er som standard afmarket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite
pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmaerket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pd jobbakke-ikonen
viser menufunktionerne for Help (Hjelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



*  Run at Startup (Ker ved opstart) er
som standard afmarket (Til). Nar den
er deaktiveret, starter SmartControl Lite
ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indleses
nar denne boks ikke er afmeaerket (er
deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.
Alle andre faneblade i SmartControl Lite er ikke
til radighed.

W smartControl 2 - Phiips 22581 (€$30715000001) {F](X)

SmartControl Lite PHILIPS

Input

Your display has two inputs (connections on back of
this display) s0 you can hook up two different sources
a ne tme. Use the al In

h source you'd ik
ng the analog in mage.

i

IMPORTANT! If you switch inputs SartCo
lose the abiity ol your monicor. I

Adiust may have to u

(83 of your monta h
before SmartControl functionalty can be restored.
\g Auto Pt
e
Color Tnput

Muli Montors

&g
/ U
B i

Help

Analog In Digial In

* Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

* P4 enkeltindgangsskeerme ses dette vindue
ikke.
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Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understgttet skeerm med DDC/CI
er kun Help (Hjzelp) og Options (Funktioner) til
radighed.

B smartControl 2 - Phiips 22581 (CS30715000001) ()X,

SmartControl Lite PHILIPS

Audio

the Volume of the ntegrated loudspeakers by
sider.

Tum off the integrated loudspeakers by checking the
Mute checkbox.

]

I mute
Adiust Audo
\g Auto Pivat
-
Color Input
st
2
Options Presets
\g Muli Monitors
Volume 100
Help = +
undo

Help > User Manual (Hjelp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjeelp) rullemenuen. P4 en ikke-understattet
skeerm med DDC/CI er kun Help (Hjeelp) og
Options (Funktioner) til radighed.

8 SmartControl 2 phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

User Manual

I you need help setting up or operating SmartControl,
clck the Tech. Support button. You'l have the
option to fil out an Assstance Form.

You can akso choose to h
\ software automaticaly attz
| form. You'll need to be or

Information about your
0 the assitance
use this feature.

Adiust
User Manual
P
a
Usdate
Color 3
s
2 Dsply
AN
\@ System 1D
Options
X%
Ny Verson
Help

User Manual Tech. Support



Help > Version (Hjelp > Version) - er kun aktiy,

narVersion (Version) er valgt i Help (Hjeelp)
rullemenuen. Pa en ikke-understattet skeerm
med DDC/Cl er kun Help (Hjzelp) og Options
(Funktioner) til radighed.

8 smartControl 2~ Phiips 22581 (C530715000001) {1

SmartControl Lite PHILIPS

Gtune-ph-R2008-12-17-

ATI2 AP

Portrai Displays, Inc.

DDC/CI Com
| Copyright ©

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmaerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Helect Preset L2
Tune Display

”Context” (Indhold) menuen har tre punkter:

* SmartControl Lite - nar valgt, ses About
(Om) skaermen.

*  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skaerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

*  Help (Hjalp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

*  Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite.

Huvis du vil kere SmartControl Lite igen,

skal du enten veelge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

SmartControl

PHILIPS

‘SmartControl
‘\ersion 3.20
dune-standard-R2007-01-04-1151-23
Copyright 1993-2007 Pertrat Displaye, Inc.
Patents Pending




Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).

@ Bemaerk

Alle billederne i dette afsnit er kun til reference.
Softwareversionen til SmartControl kan &ndres
uden varsel. Se venligst altid pa den officielle
Portrait webside www.portrait.com/dtune/
phl/enu/index for at downloade den seneste
version af SmartControl softwaret.
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4. Tekniske specifikationer

Billede/Skarm

Skeermpaneltype TFI-LCD

Baggrundslys LED

Panelstarrelse 19,5" W (49,4cm)

Billedforhold 16:9

Pixel pitch 0,26 x 0,26 mm

Lysstyrke 200 cd/m? for 203V5LSB2/203V5LSU2/203V5LHSB2;
250cd/m? for 203V5LSB/203V5LSU

Smart-kontrast 10,000,000:1

Kontrastforhold (norm.) 600:1

Reaktionstid (norm.) 5ms

Optimal oplgsning 1600 x 900 pa 60 Hz

Synsvinkel 90° (H) / 50° (V) ved C/R > 10

Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30l<Hz 83kHz

sRGB

Inputsignal VGA (Analog)(203V5LSB/203V5LSU/203V5LSB2/203V5LSU2);
HDMI(203V5LHSB2)

Input5|gnal Separat synk., synk. pa gren

Brugerfunktloner
Engelsk,Tysk, Spansk, Greesk, Fransk, taliensk, Ungarsk, Hollandsk,

Conpe— Port'ugisisk, Blrasiliansk—portggisisk, Rusgisk, Polislkl, Svengk, Fihsk.
Tyrkisk, Tjekkisk, Ukrainsk, Simpel Kinesisk, Traditionel Kinesisk,
Japansk, Koreansk

VESA montering 100 x 100 mm

Andre funktioner Kensington-las

"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 8/ Windows 7/ Vista/XP Mac OSX,
Linux

Vip -3/+10

Teendt-tilstand 203V5LSB2/203V5LSU2:15,8W (typ.), 16,71W (maks.)

203V5LSB/203V5LSU: 18.29W/(typ.), 18.98W (maks.)
203V5LHSB2: 17.69W/(typ.), 18.46\W (maks.)

| dvale (Standby) 0,5W

Fra 0,5W

Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50-60Hz
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Mal
Produkt uden fod (B x H x D)

465 x 345 x 169 mm

Produkt uden fod (B x H x D)

465 x 282 x 48 mm

Produkt med fod 2,33kg(LED)
Produkt uden fod 2,03kg(LED)
Produkt med emballage 3,23kg(LED)

Driftsforhold

Overholdelse og standarder
Myndighedernes godkendelser

Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°C til 60°C

Relativ fugtighed 20% til 80%

MTBF 30.000 timer(LED)
ROHS JA

EPEAT (Optional) Silver (www.epeat.net)
Emballage 100 % genbrugelig
Energy Star (Optional) JA

CE Meerket, FCC Klasse B, CU, SEMKO, ETL, 1ISO9241-307,

(Optional) SASO, EPA, CB, PSB, KUCAS, TBS CoC
Farve Sort
Overflade Tekstur
& Bemark
1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net
for registreringsstatus i dit land.
2. Disse data kan andres uden varsel. Ga til www.philips.com/support for at hente den seneste

version af brochuren.




4.1 Oplesning og forudindstillede
funktioner

Maksimal oplgsning
1600 x 900 ved 60 Hz

V frekv. Oplgsning L frekv. (Hz)
(kHzx)
31.47 720 x 400 70.09
31.47 640 x 480 59.94
35 640 x 480 66.67
37.86 640 x 480 72.81
375 640 x 480 75
37.88 800 x 600 60.32
46.88 800 x 600 75
48.36 1024 x 768 60
60.02 1024 x 768 75.03
44.77 1280 x 720 59.86
63.89 1280 x 1024 60.02
7998 1280 x 1024 75.03
60 1600 x 900 60
S Bemark

Bemaerk venligst at din skaerm virker bedst med
native oplasning pa 1600 x 900 ved 60Hz. For
at opna den bedste skaermkvalitet, bedes du
venligst bruge denne oplasning.
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5. Stremstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skaermen automatisk
nedsatte stremforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

203V5LSB2/203V5LSU2(Analog only)

Energispare-definition

VESA |
distang | Video [ Visynk | Lsynk | Opbrugt strom | LED Farve
158W (typ).
Ay TIL ) e B 7w maksy | M9
| dvale : : Hvid
(Standy) | A | N | Nl OSWIHR) - per)
Kontakt Fra| FRA 05W (typ.) FRA
203V5LSB/203V5LSU
Energispare-definition
VESA |,
iy | Video [ Visynk | Lsynk | Opbrugt strom | LED Farve
Aktiv | Ja 1829W (WP | g
1898W (maks)
| dvale X . Hvid
(Standoy) | TRA | N | NeF ] OSWOR) | inery
Kontakt Fra| FRA 05W (typ)) FRA
203V5LHSB2
Energispare-definition
VESA |,
iy | Video [ Visynk | Lsynk | Opbrugt strom | LED Farve
Adv | TIL | R | e | T7EWORL
18.46W (maks.)
| dvale . : Hvid
(Standby) | RA | Nl [ Nef | OSW®P) | pjien
Kontakt Fra| FRA 05W (typ)) FRA

20

Folgende opsatning bruges til at male
skaermens stremforbrug,

* Indbygget oplasning: 1600 x 900
*  Kontrast: 50%
*  Lysstyrke: 200 nits or 250 nits

» Farvetemperatur: 6500k med fuldt, hvidt
mgnster

@ Bemaerk
Disse data kan andres uden varsel.



6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

X, The EPEAT (Electronic
QQ' Product Environmental
& Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

«  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

«  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
Uzpedzenie powiano byt rasilane z paiasds 2 preylaceonym obwodem ochronmym (gnisedo
katkiem). Wapdipracuiaee 2 soby ufzadzenia (Komputer, monitor, drukarka) powinty bye msilane
& togo samego dridla
Instalacja elektrycna pomiesaczenia powinna mwie
przs zwarciami, w postaci bezpieconika o warke
W el catkowitogo wybyerenia urspdzents 2 siect zasilania, nalezy wyint wiycekg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Znak bespieczefsrwa "B” potwierdzs 2podnosé uresdzenia » wymaganiami bezpiecsefaiwa
whytkowania awartymi w PN-93T-42107 | PN-§9E-D6;

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.

warostami lub spad-
X

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-

plerwy i

etz wokdl niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@RGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skaerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skeerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
gaelder i hele verden.

sub-pixler sub-pixler  sub-pixler

T

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primzrfarverne red, gren og
bla. Nar mange pixler settes ssmmen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstdr som
enkelte pixler i andre farver

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skaeermen viser et
mearkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I C

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla
- Red + Grgn = Gul

- Grgn + Blda = Cyan (Lysebld)

Tre sammenliggende tendte pixler (en hvid
pixel).
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@ Bemaerk

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte mgrke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er“slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et mgrkt menster. Der er
folgende typer defekte marke prikker.

Tetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

3 Tre sammenliggende teendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 mark sub-pixel 5 eller ferre

2 sammenliggende marke sub-pixler 2 eller faerre

3 sammenliggende marke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre

@ Bemaerk

1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt

2. Denne monitor er i overensstemmelse med 1SO9241-307 (1SO9241-307: Testmetoder for
ergonimiske kray, analyse og overensstemmelse pa elektroniske visuelle skeerme)
3. 1SO9241-307 is de opvolger van de voormalige ISO13406-standaard, die op 13 november 2008

ingetrokken is door de International Organisation for Standardisation (ISO).




7.2 Kundeservice og garanti

For oplysninger om garantidaekning og gzeldende stattekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger til LATINAMERIKA:
Land Callcenter Kundeservice tif

Brazil 0800-7254101

: Vermont
Argentina 0800 3330 856

Kontaktoplysninger tii NORDAMERIKA:

Land Callcenter ASC Kundeservice tIf
USA. EPl-e-center | Qwantech (877) 835-1838
Canada EPl-e-center | Qwantech (800) 479-6696

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tlf Pris

Austria RTS +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06

Cyprus Alman 800 92 256 Free of charge
Denmark Infocare +45 3525 8761 Local call tariff
Finland Infocare +358 09 2290 1908 Local call tariff
France Mainteq +33 082161 1658 €0.09
Germany RTS +49 01803 386 853 €0.09

Greece Alman +30 00800 3122 1223 Free of charge
Ireland Celestica +353 01 601 1161 Local call tariff
[taly Anovo ltaly +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway Infocare +47 2270 8250 Local call tariff
Poland MSI +48 0223491505 Local call tariff
Portugal Mainteq 800 780 902 Free of charge
Spain Mainteq +34 902 888 785 €0.10
Sweden Infocare +46 08 632 0016 Local call tariff
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff
United Kingdom Celestica +44 0207 949 0069 Local call tariff




Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tIf
+
Belarus NA IBA ORI
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
o [ e
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service l.l.c. +7 727 3097515
+
Latvia NA ServiceNet LV +§;1 g;;zggzz
Lithuania NA UAB Servicenet Ig;g ;47}0%%08186(()150%25:?;)3 )
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
;egﬁitaefegm NA Kim Tec d.0.0. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of |\, Sy +375 17 284 0203
Belarus
Turkey NA Techpro +90 212 444 4 832
et NA Comel +380 5627444225
NA Topaz +38044 525 64 95

Kontaktoplysninger til Kina:

Kina

Kundeservice tlf: 4008 800 008
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Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tlf
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand [ NA Visual Group Ltd. 0800 657447
Hong Kong / NA Company: Smart Pixels Hong Kong:Tel: +852 2619 9639
Macau Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
Indonesia NA PT. CORMIC SERVISINDO +62-21-4080-9086 (Customer Hotline)
PERKASA +62-8888-01-9086 (Customer Hotline)
Korea NA Alphascan Displays, Inc. 1661 — 5003
Malaysia NA R-Logic Sdn Bhd +603 5102 3336
Pakistan NA TVONICS Pakistan +92-213-6030100
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3966
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Computer Repair Technologies | 011 262 3586
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Company Ltd. - Ho Chi Minh +84 5113.562666 Danang City
City Branch +84 5113.562666 Can tho Province
Philippines | INA EA Global Supply Chain (02) 655-7777; 6359456
Solutions ,Inc.
Armenia
Azerbaijan
Georgia NA Firebird service centre +97 14 8837911
Kyrgyzstan
Tajikistan
Usbekistan NA if[)dmko Plus Private Enterprise +99871 2784650
Turkmenistan | NA Technostar Service Centre +(99312) 460733, 460957
T4V TAE=H— - PR
Japan NA Ry 03-5676-6022
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan

klares af brugeren selv. Hvis problemet stadig er

der; efter at du har prevet disse lasninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat |
stikkontakten og bag pa skaermen.

*  Kontroller fgrst, at strgmkontakten foran
pa skaeermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
»  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede

stikben pa signalkablets stik. Hvis der er det,

skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek, om skeermkablets stikben er bgjede.

» Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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& Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
*  Forsgg ikke selv at fejlfinde

e Treek straks skeermens stik ud af
stikkontakten

»  Kontakt straks en repreesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

=

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

*  Eliminer de lodrette bjelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.




Billedet er slgret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmaerkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt feenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

*  Serg altid for at aktivere en pauseskeerm,
der beveaeger sig, nar skeermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskeerm eller
et andet program, der opdaterer skaeermen
regelmeessigt, hvis LCD skeaermen viser
statisk materiale i leengere perioder.

* Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvranget. Tekst er utydelig eller

slaret.

* Indstil pc'ens skeermoplasning som
skaermens anbefalede, native oplgsning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Teendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Taendt” lyset med
Stremdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.

32

8.2 Generelle FAQ

SP1: Hvad skal jeg gore, hvis skermen under

installationen viser “Cannot display

this video mode” (Kan ikke vise denne

videotilstand)?

Sv.. Den anbefalede oplasning pa denne

skaerm: 1600 x 900 pa 60 Hz.

*  Frakobl alle kabler og forbind derefter

pc'en til skeermen, som du brugte for

* | Windows Startmenuen, valg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet veelg
Display (Skaerm)-ikonet. | Egenskaber for
Skeerm-vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet ""desktop area" (skrivebordsomrade),
skal du stille justeringsbjaelken pa 1600 x
900 pixler.

+  Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1600 x 900 ved 60 Hz.

*  Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skaermen.

* Tend for skermen og derefter for pc'en.

SP2: Hvad er den anbefalede
opdateringshastighed pa LCD skarmen?
Sv..  Den anbefalede opdateringshastighed
pa LCD skerme er 60 Hz. | tilfeelde af
forstyrrelser pa skaermen skal du sztte
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Sv.:  Dette er skeermens driverfiler: Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skaeermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skaermen

forste gang. Indset (medfglgende cd-rom)



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

i pakken i henhold til vejledningerne.
Skaermdrivere (inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplgsningen?

Skaermkortet/grafikdriveren og skaeermen
bestemmer sammen oplgsningerne til
radighed. Du kan veelge den gnskede
oplesning under “Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen?

S3 skal du blot trykke pa OK og derefter
vaelge "Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skeermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skermens
overflade?

Til normal renggring skal du blot anvende
en ren, bled klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplasningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skarmens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow” (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. Farvetemperatur med to indstillinger;
6500K og 9300K. Med indstillinger i
6500K omradet virker skaermen “‘varm,
med en rgd-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan velge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

& Bemerk

En malning af farven pa lys, der udstrdles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rede,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur; 6504K, er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skarme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere npdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler;
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger:

SP10: Er Philips LCD skaerme “Plug & Play”?

Sv.: Ja, skeermene er “Plug & Play” kompatible
med Windows 8/ Windows 7/ Vista/XP/
NT, Mac OSX og Linux

SP11: Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
leengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spggelsesbilleder” pa skaermen.
“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skermteknologi. | de
fleste tilfeelde vil “brandmerkerne” eller
“efterbilledet” eller “spggelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskzerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder

O Advarsel

Hvis der ikke aktiveres en pauseskaerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbreendinger” eller
“efterladte billeder” eller "spggelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstdende skade daekkes ikke af
garantien.

SP12: Hvorfor viser skaeermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv.. Din LCD monitor virker bedst pa dens
native oplgsning pa 1600 x 900 ved
60 Hz. Brug denne oplasning for at opna
det bedste billede.
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